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About Practice CS Reports 
Practice CS offers a variety of reports that provide you access to the decision-making information you 
need to effectively manage your firm and analyze your Practice CS data for performance and profitability.  

This guide will walk you through the basic steps of creating, previewing, and printing reports; selecting 
report options to refine the data presented in your reports; creating report profiles to save time setting up 
and printing reports; and “drilling down” into reports for more information about the source of report data. 

Note: For best results when printing this guide from Adobe® Reader,® mark the Auto-Rotate and Center 
checkbox in the Print dialog. 

Types of reports 
Practice CS reports fall into five general categories. 

 Listings enable you to print simple hardcopy lists of data and the various groupings you have set up in 
the program. An example is the Activity Listing. 

 Production reports allow for analysis of firm production. An example is the Time & Expense Journal. 

 Billing reports, such as the Billing Analysis report, enable analysis of firm billings. 

 Collection reports allow for analysis of accounts receivable balances. The Accounts Receivable 
Summary is one example of a Collection report. 

 Reconciliation reports provide summaries of the firm’s work-in-process, billing, and accounts 
receivable activity for a selected date range. An example is the Period Reconciliation report. 

Note: If your firm uses the security features in Practice CS, you can restrict access to certain reports 
using the Security Groups setup screen. For additional information on report security, see “Security 
options” on page 12. 
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Opening the Print Reports screen  
To access the Print Reports screen, you can do any of the following: 

 From the File menu, choose Print Reports 

 Click the Firm button in the navigation pane, then click the Print Reports action icon 

 Press CTRL+P  

Tip: You can click the double arrow  at the top of the navigation pane to hide it.   

    

 



 About Practice CS Reports 

Practice CS Sample Reports 3 

Report options 
For each report, you can customize the results by choosing dates, ranges, and filters for report criteria. 
Use the Selection and Layout tabs to define these criteria before printing.  

Note: Selections available in these tabs vary depending on the report you have selected. 

Description 
The Description field shows the report name. If you want to give a report a different name, enter it in the 
Description override field. Text that you enter in this field is displayed as the report title when you preview 
or print the report and is used as the file name when you print the report to FileCabinet CS,® to 
GoFileRoom,® to a file, or to an email message. When you save a report with a description override to a 
report profile, the override text will appear as the report name when you select the profile and when you 
view the profile details. See “Creating report profiles” on page 9 for more information on report profiles. 

Date ranges 
Selection tab — Use the Selection tab to specify the report date, detail line dates, and any additional 
filters you want to employ. You can also indicate a date range for the detail lines. This tab also includes 
filtering fields that enable you to narrow the scope of data that appears on a report.   
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Grouping and sorting options 
Layout tab — Use the Layout tab to select grouping options for the data and indicate how details should 
be displayed on the report. Mark the Page Breaks checkbox to force a new page for each grouping. For 
example, if you marked the Page Breaks checkbox for the Client Partner grouping pictured below, each 
partner’s data would begin on a new page. If you mark the Print Cover Sheet checkbox, the report will list 
the report options you selected before printing.   

 

Previewing reports 
The Preview screen enables you to view your reports before printing. It also provides a way to trace data 
on a report back to its source. To preview a report, select a report from the reports list, edit the report 
options as needed, and click the Preview Selected button. 

Example: Previewing the Activities report 
In this example, you will set up and preview the Activities report. 

Note: List reports enable you to print simple hardcopy lists of the various groupings you have set up in 
the program. The names of these groupings are firm terminology variables. Your firm might use a term 
other than Activity for this or other groupings. To view the default terms for these groupings, choose Help 
> Enable Default Terminology.  
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1. Open the Print Reports screen (File > Print Reports). 

2. Click the Activities report, and then click the Select button. 

3. Leave the Selection tab unchanged and click the Layout tab.  

4. In the Group by field, select Activity Category. 

5. In the Sort on field, verify that ID is selected.    

6. Click the Preview Selected button.  
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7. In the preview screen, note how the list of activities is grouped and sorted. 

8. Click the Back button on the toolbar to return to the Print Reports screen.   

 

Using the report preview to access source data 
In Practice CS, the report displayed in the Preview screen is interactive. You can click items in the report 
to trace the data back to its origins. When you move your mouse pointer over data that is interactive, the 
pointer changes from an open hand  to a pointing hand . For some data, clicking the item within the 
Preview screen lets you “drill down” to another report showing the relevant source data. For other data, 
clicking the item will open the screen where the data was originally entered.   

In this example, you will preview the Time and Expense Journal report to see the individual time entries 
that make up an item on the report. 

1. Select the Time and Expense Journal report. 

2. Click the Select button. 

3. For this example, click the Layout tab, and choose <None> in all Group by fields. 

4. Clear the Page Breaks and Print Cover Sheet checkboxes if they are marked. 

5. Click the Preview button. 
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6. In the Preview screen, click 5.00 in the Hrs/Units column of the first row in the following illustration.   

 
7. The Time & Expense Entry screen opens. Here you can see the individual time entry for the item that 

you clicked in the report preview.   

 
8. To return to the report preview screen, click the Back button in the toolbar. 
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Printing a report 
In this example, you will select the Time and Expense Journal report and print it to a file on your desktop. 

1. In the Print Reports screen, select the Time and Expense Journal report from the list of reports. 

2. Click the Select button to move it to the Selected Reports list.  

Notes  

 You also can double-click reports and profiles to add or remove them from the Selected Reports  
list.  

 To reorder the Selected Reports list, click and drag a report or profile name to the desired 
location in the list.  

3. For this example, use the default options in the Selection and Layout tabs.  

4. Click the Preview Selected button to preview the report before printing. 

Note: You can print reports directly from the Print Reports screen by clicking the Print Selected 
button. However, when you print from the Print Reports screen, the page range options in the Print 
dialog are unavailable. 

5. In the Report Viewer, choose File > Print to open the Print dialog.  

6. In the Print dialog, you can choose to print the report to one or more of the following outputs:  

 Printer: Sends the report to the default printer for your workstation. To print to another printer,  
select it from the drop-down list.  

 FileCabinet CS: If you are licensed for FileCabinet CS,™ mark this checkbox to send the reports 
to FileCabinet CS when you print. Each report will be sent as one item with the same name as 
the report. You must also choose whether the reports should go to a client's drawer or a staff 
member's drawer.  

 GoFileRoom: If you are licensed for GoFileRoom, mark this checkbox and choose a file format 
(*.pdf, *.rtf, *.txt, or *.xls) from the drop-down list to send the report to GoFileRoom when you 
print. 

Note: Before you can print to GoFileRoom, you must first map your GoFileRoom Indexes to fields 
in Practice CS. See the topic GoFileRoom index mapping in the Practice CS Help & How-To 
Center for more information. 

 File: Enables you to print the report to a file (*.pdf, *.html, *.rtf, *.txt, *.tif, or *.xls). The file is  
saved in the folder that you specify in the field provided.  

 Email: Enables you to print the report as a specific file type and then email the file to the 
recipients you choose. In the field provided, enter the recipients' email addresses separated by a 

semicolon (;) or click the   button and select the addresses from your address book.  

For this example, mark the File checkbox and clear all other checkboxes.  

Choose Rich Text Format as the file type, click the  button next to the Destination field, select 
Desktop, and click OK to return to the Print dialog. 

7. Click OK to print the report to your selected output(s).  

http://cs.thomsonreuters.com/ua/practice/cs_us_en/setup/csh_gofileroomsetupform.htm?product=practice&mybanner=1
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8. Click the Back button  on the toolbar to exit the report preview. 

The report you printed is now on your computer desktop as a Rich Text Format (RTF) file.  

Filtering report data 
Use the Selection tab of the Print Reports screen to apply filters. Filters can narrow the data to only that 
which interests you. For example, when printing the Billing Analysis report, you could include only AUDIT 
engagement data for three specific members of your staff. To create this filter, you would choose an 
Engagement filter, then is as the filtering method, followed by the AUDIT engagement. Then you would 
choose a Staff filter, then choose is in the list as the filtering method, and then select the staff members 
from a staff list.   

 

Creating report profiles 
A report profile is a feature that can save you time if you often need to print the same set of reports. 
Creating a profile lets you pre-define the specific reports you want to print, in the exact collation 
sequence, and with the specific print options (such as date ranges and sort order) that you choose. After 
you save the profile, you can then select it as if it were a single report. 

Note: The Most Recently Printed profile consists of the reports, along with their options, that you most 
recently previewed and/or printed. You cannot modify or delete this profile. 
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Creating a report profile 
To add a profile, do the following. 

1. From the File menu, choose Print Reports.  

2. In the Print Reports screen, select the reports you want to include in the profile.  

Note: You can also select existing profiles to add to the new profile. 

3. In the Report Options Selection and Layout tabs, choose the desired print options for each report.  

4. Click the Profiles button.  

5. In the Profiles dialog, enter a name (up to 30 characters) for the profile in the Description field.   

 
6. Reports in the profile are displayed in the order in which you selected them. If you want to change  

the print order of the reports, click and drag the reports to reorder them.  

7. Click the Add button to save the profile. 

Updating a report profile 
To make changes to a saved profile, do the following. 

1. In the Print Reports screen, select the profile you want to update.  

2. If you want to add or remove a report from the profile, highlight the report and click the Select or 
Remove buttons.  

3. If you want to change the report setup for a report in the profile, highlight that report, click the 
Selection or Layout tab under Report Options, and make the desired changes.  

4. Click the Profiles button.  

5. In the Profiles dialog, you can make the following changes to the profile:  

 Change the name in the Description field.  

 Click and drag the reports to reorder them.  

 Click the Delete button to delete the profile.  

6. Click the Update button to save your changes.  
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Customizing reports 
Practice CS enables you to create custom reports based on the standard reports shown in this sample 
reports guide. Use the Custom Formats screen (Setup > Custom Formats) to modify a standard report, 
customize a copy of a standard report, or create an entirely new report based on one of the standard 
report formats. 

You can also download reports created by the Practice CS Development staff or by other users. Add the  
Practice CS Library portlet to any dashboard, and browse the available report formats. If you create a 
custom report that you want to share with others, submit it to the Development staff using the link 
provided in the Practice CS Library portlet. Your report could be added to the Practice CS Library for 
others to download and use. 

For more information on creating your own custom reports, refer to the Practice CS Custom Formatting 
WalkThrough, which is available from the Help Videos & PDFs section of the Practice CS Library portlet.  

Note: You can also access the walkthrough by choosing Help > Help & How-To Center and entering 
Viewing Practice CS guides in PDF in the Search for assistance field in the Practice CS toolbar.    
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Security options 
If your firm uses the security features in Practice CS, you can control security privileges for reports for 
members of various security groups. For a selected group, you can allow or restrict privileges for all 
reports, or choose certain reports that members of the group can access. 

Setting up security 
To turn on security features in Practice CS, choose Setup > Firm and click the Preferences tab. Mark the 
Enable Firm Security checkbox and click Enter to save your changes. You will then need to close and re-
open the firm database to access security group settings. For more information on setting up security 
groups and assigning staff members to those groups, please see the topics Setting up security groups 
and Assigning staff to security groups in the Practice CS Help & How-To Center. 

To manage security settings for reports, choose Setup > Security Groups and expand the Privilege 
Selection list through Practice CS > Menu > File Menu > Print Reports. From there, you can mark or clear 
the Print Reports checkbox to control privileges for all reports, or mark or clear the checkboxes for types 
of reports (Lists, Production, Collection, and so on) or individual reports. 

Security dependencies 
Some reports rely on data that you may have already restricted for certain users. When you enable 
security privileges for a report on the Security Groups setup screen, Practice CS may also enable 
privileges to view the data available on the report. Conversely, removing privileges for viewing data may 
also remove privileges for related reports. Consult the Privileges changed pane on the Security Groups 
setup screen to see all privilege changes that are triggered by enabling access to a report. 

To see the dependent privileges related to a report, read the Important Security Note on the topic for that 
report. In Practice CS, choose Help > Help & How-To and use the Search for assistance 

 field in the Practice CS toolbar to find the topic matching the name of the report.  

Note: For reports of the List type, see the topic List reports in the Practice CS Help & How-To Center.  

Multi-office security 
If your firm has multiple offices, you may want to rescind privileges to information for other offices. For 
more information, see the topic More about security privileges in the Practice CS Help & How-To Center. 

 

http://cs.thomsonreuters.com/ua/practice/cs_us_en/setup/firm_admin/csh_securitygroupsetupscreen.htm?product=practice&mybanner=1
http://cs.thomsonreuters.com/ua/practice/cs_us_en/setup/firm_admin/assigning_staff_to_security_groups.htm?product=practice&mybanner=1
http://cs.thomsonreuters.com/ua/practice/cs_us_en/Reporting/listing_reports.htm?Product=practice&mybanner=1
http://cs.thomsonreuters.com/ua/practice/cs_us_en/setup/firm_admin/more_about_security.htm?product=practice&mybanner=1
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List Reports 
List reports enable you to print lists of staff, clients, and other information from Practice CS. You can 
group lists by criteria that you specify, and apply filters to narrow the report results. The following reports 
are included in this section. 

Activities ...................................................................................................................................................... 14 
Activity Categories ...................................................................................................................................... 18 
Client Groupings ......................................................................................................................................... 19 
Client/Engagement ...................................................................................................................................... 23 
Clients ......................................................................................................................................................... 27 
Contacts ...................................................................................................................................................... 30 
Departments ................................................................................................................................................ 32 
Engagement Categories ............................................................................................................................. 33 
Engagement Templates .............................................................................................................................. 34 
Entities ......................................................................................................................................................... 34 
Staff Billing Rates ........................................................................................................................................ 36 
Staff Groupings ........................................................................................................................................... 40 
Staff Levels ................................................................................................................................................. 43 
Standard Text .............................................................................................................................................. 44 
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Activities  
The Activities report lists activities that have been set up for your firm. It can be grouped by type (such as 
time or expenses), class (billable, nonbillable), or category (a grouping within activities, such as write-up, 
payroll services, auditing, and so on).  

  

Activities report grouped by Activity Type   
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Activities report grouped by Activity Class   
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Activities report grouped by Activity Category   
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Drill-down capabilities for Activities report — Click any ID or Description item to open the Activities 
setup screen for the corresponding record.   
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Activity Categories   
The Activity Categories report lists the activity categories that have been set up in Practice CS.  

Drill-down capabilities — Click any ID or Description item to open the Activity Categories setup screen 
for the corresponding record.  
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Client Groupings 
The Client Groupings report is a client-based report, meaning it can be grouped by various client criteria, 
such as client partner, office, or entity.   

 

Client Groupings report grouped by Client Office   
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Client Groupings report grouped by Client Partner   
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 Client Groupings report grouped by Client Entity   
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Drill-down capabilities for Client Groupings report — Click any ID or Description item to open the 
Clients setup screen for the corresponding record.  
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Client/Engagement 
The Client/Engagement Listing report lists the engagements that are assigned to your clients. It is a 
client-based report, meaning it can be grouped by various client criteria, such as client partner, office, or 
entity. 

 

Client/Engagement report grouped by Client Office   
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Client/Engagement report grouped by Client Partner   
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Client/Engagement report grouped by Client Entity   
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Drill-down capabilities — Click any ID or Description to open the Clients setup screen for the 
corresponding record.    
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Clients 
The Clients report lists your firm’s clients. It is a client-based report, meaning that it can be grouped by various client criteria, such as client 
partner, office, or entity. 

 

Clients report grouped by Client Partner, detail by Client ID in ascending order  
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Clients report with no groupings, detail by Client ID in ascending order  
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Drill-down capabilities for Clients report — Click any item to open the Clients setup screen for the corresponding record.   
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Contacts 
The Contacts report lists all of your firm’s contacts, along with their titles, associations, and contact information. It enables you to print a list of 
contacts grouped by various criteria.   

 

Contacts grouped by Client, detail by Contact   
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Drill-down capabilities for Contacts report — Click any field in the report preview to drill down to the 
Contact dialog for the corresponding contact.   
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Departments    
The Departments report lists the staff departments that have been set up in Practice CS. 

Drill-down capabilities — Click any ID or Description item to open the Staff Departments setup screen 
for the corresponding record.   
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Engagement Categories 
The Engagement Categories report lists the engagement categories that have been set up in Practice 
CS. 

Drill-down capabilities — Click any ID or Description item to open the Engagement Categories setup 
screen for the corresponding record.   
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Engagement Templates 
The Engagement Templates report lists the engagement templates that have been set up in Practice CS.  

Drill-down capabilities — Click any item within the body of the report preview to open the Engagement 
Templates setup screen for that engagement template.   
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Entities     
The Entities report lists the client entities that have been set up in Practice CS. 

Drill-down capabilities — Click any ID or Description item to open the Client Entities setup screen for 
the corresponding record.   
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Staff Billing Rates 
The Staff Billing Rates report lists the different rates set up for staff. In addition, it displays the cost per 
hour for each staff. It can be grouped by staff office, department, or level, among other criteria. 

 

Staff Billing Rates grouped by Staff Office    
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Staff Billing Rates grouped by Staff Department   
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Staff Billing Rates grouped by Staff Level   
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Drill-down capabilities for Staff Billing Rates report — Click any ID or Name item to open the Staff 
setup screen for the corresponding record. 
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Staff Groupings 
The Staff Groupings report lists all available groupings for your staff. It can be grouped by staff office, 
department or level, among other criteria. 

 

Staff Groupings report grouped by Staff Office    
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Staff Groupings report grouped by Staff Department    

 

Staff Groupings report grouped by Staff Level    
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Drill-down capabilities for Staff Groupings report — Click any ID or Sort Name item to open the Staff 
setup screen for the corresponding record.     
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Staff Levels 
The Staff Levels report lists the staff levels that have been set up in Practice CS. 

Drill-down capabilities — Click any ID or Description item to open the Staff Levels setup screen for the 
corresponding record. 
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Standard Text  
The Standard Text report lists any standard text that has been set up in Practice CS. 

Drill-down capabilities — Click any ID or Description item to open the Standard Text setup screen for 
the corresponding record.    
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Production Reports 
Production reports enable you to view and analyze your firm’s billable and non-billable time and 
expenses. These reports can assist in analyzing production from a number of perspectives, including 
client, staff, engagements, and activities. Production reports can be used to identify areas with the most 
potential for profitability, or to discover areas where efficiency can be improved. 

The following reports are included in this section. 

Production Analysis ..................................................................................................................................... 46 
Time and Expense Journal ......................................................................................................................... 52 
Time and Expense Listing ........................................................................................................................... 56 
Timesheet Exception ................................................................................................................................... 60 
Work-in-Process Summary ......................................................................................................................... 61 
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Production Analysis 
The Production Analysis Report analyzes time worked and client expenses incurred for a given period. The groupings on this report are very 
flexible, and include various activity, client, engagement, and staff groupings. The detail of the report can be shown in a variety of ways as well. 
Filtering and date ranges enable you to see only the information needed. 

 

Production Analysis, grouped by Client, detail by Activity ID in ascending order    
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Production Analysis, grouped by Client Office, detail by Client ID in ascending order    
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Production Analysis with no groupings, detail by Staff ID in ascending order    



 Production Reports 

Practice CS Sample Reports 49 

 

Production Analysis with Detail line Year-to-date, and Detail line 2 Previous Year Year-to-date, detail by Client ID in ascending order      
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Production Analysis chart with Detail by Client Office 
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Drill-down capabilities for Production Analysis report — Click any ID, Name/Description, Admin, Non-Bill, Billable, or Total Hrs/Units item to 
open a Time and Expense Listing report showing the entries that make up the corresponding item.   
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Time & Expense Journal 
The Time and Expense Journal lists records of time and expense entries that were entered into the system for a specified date range. Its 
numerous grouping options include Activity, Engagement, Staff, and Date. Filtering and date range options enable you to view only the information 
you need. 

 

Time & Expense Journal grouped by Client ID    
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Time & Expense Journal grouped by Staff ID, detail by Date in ascending order     
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Time & Expense Journal grouped by Staff ID, detail by Engagement in ascending order     
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Drill-down capabilities for Time & Expense Journal report — Click any item in the detail line to open the Time & Expense Entry screen to the 
corresponding item.    
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Time and Expense Listing 
The Time & Expense Listing is a slightly more comprehensive reporting of time & expense entries than the Time & Expense Journal. The main 
purpose of this listing is for drill-down reporting, but it also can be printed on its own. Its numerous grouping options include Activity, Engagement, 
Staff, and Date. Filtering and date range options enable you to view only the information you need. 

 

Time and Expense Listing grouped by Client ID, detail by Sheet Date in ascending order     
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Time and Expense Listing grouped by Staff ID, detail by Order Entered in ascending order   
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Time and Expense Listing grouped by Staff ID and Engagement ID, detail by Sheet Date in ascending order   
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Drill-down capabilities for Time and Expense Listing report — Click any item in the detail line to open the Time & Expense Entry screen to the 
corresponding item.     
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Timesheet Exception report 
The Timesheet Exception report shows a list of staff and their total hours for the selected date range, 
including billable, nonbillable, admin, total time, comp time, and net time.  

Note: Comp time and net time are shown only if you are licensed for the Staff Management module. 

Drill-down capabilities — Click an item in any column except Comp or Net Time to open a Time and 
Expense Listing report for the entries that make up that item.    
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Work-in-Process Summary 
The Work-in-Process Summary report combines two different styles of reports: Recap and Aging. This combination provides a useful overview or 
summary of the status of work-in-process (which is defined as time and expenses with a class of “billable” that have not yet been billed). Its 
numerous grouping options include Activity, Engagement, Staff, and Date. Filtering and date range options enable you to view only the information 
you need.  

 

Work-in-Process Summary grouped by Client ID, detail by Activity ID in ascending order     
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Work-in-Process Summary with no groupings, detail by Client ID in Descending order     
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Work-in-Process Summary grouped by Client Partner ID and Engagement ID, detail by Client Sort Name in ascending order     
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Work-in-Process Summary with Detail line Year-to-date, and Detail line 2 Previous Year Year-to-date, detail by Client ID in ascending 
order    
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Work-in-Process Summary graph with Detail by Client Office 
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Drill-down capabilities for Work-in-Process Summary report — Click any ID, Name/Description, or End Bal item in the detail line to open a 
Time and Expense Listing report showing the corresponding item. Click an item on that report to open the Time & Expense Entry screen to the 
entries that make up the corresponding item.   
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Billing Reports 
Billing reports enable you to make more informed billing decisions. Billable time and expenses can be 
seen from many different perspectives, including clients, engagements, activities, and staff. These reports 
will also assist you in analyzing billed time and expenses, and will help you determine which clients, staff, 
engagements, or activities have the most or least realizable value. 

The following reports are included in this section. 

Billed Tax Summary .................................................................................................................................... 68 
Billing Analysis ............................................................................................................................................ 70 
Billing Worksheet ........................................................................................................................................ 76 
Invoice Journal ............................................................................................................................................ 80 
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Billed Tax Summary 
The Billed Tax Summary report lists taxable amounts and the tax amounts charged by each taxing 
authority. It is detailed by Taxing Authority, and can be grouped by a variety of criteria related to activities, 
clients, engagements, projects, and staff.  

 

Billed Tax Summary grouped by Client Office     
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Billed Tax Summary with Detail line Year-to-date, and Detail line 2 Previous Year Year-to-date    

Drill-down capabilities for Billed Tax Summary report — N/A.   
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Billing Analysis 
The Billing Analysis report provides information on billing decisions related to time & expenses for the specified period. The report helps you 
analyze the realization percentage of your firm's billing rates, margin, and which clients, staff, or services are most profitable. The report lets you 
determine whether your firm was able to bill for your staff's assigned rates, and the difference between what you are billing and the cost to the firm. 
Its numerous grouping options include Activity, Engagement, Staff, and Date. Filtering and date range options enable you to view only the 
information needed.    

 

Billing Analysis grouped by Client ID, detail by Activity ID in ascending order     
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Billing Analysis grouped by Engagement Biller ID, detail by Client ID in ascending order     
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Billing Analysis grouped by Client Partner ID and Staff ID, detail by Staff Sort Name in ascending order    
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Billing Analysis with Detail line Year-to-date, and Detail line 2 Previous Year Year-to-date, detail by Client ID in ascending order  
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Billing Analysis chart with Detail by Client Partner 
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Drill-down capabilities for Billing Analysis report — Click any ID, Name/Description, Hrs/Units, Amount, or Adjusted item in the detail line to 
open a Time & Expense Listing report showing the corresponding item. Click an item on that report to open the Time & Expense Entry screen to 
the corresponding item.   
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Billing Worksheet 
The Billing Worksheet report is designed to allow billers to make informed billing decisions. The report provides comprehensive billing information 
but is flexible enough to let you choose only the information you need. The detail can be grouped in numerous ways, and can also have different 
sections for AR information.   

 

Billing Worksheet grouped by Client Partner ID, group detail by Engagement, and detail is by Engagement in ascending order     
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Billing Worksheet grouped by Client Office ID, Group Detail is by Engagement ID, and detail is by Staff in ascending order    
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Billing Worksheet, Group Detail is by Staff Sort Name, and detail is by Activity in ascending order     

Notice the Accounts Receivable Open Items and the Aging WIP & A/R sections at the top of the report. 
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Drill-down capabilities for Billing Worksheet — Click any item in the detail line to open the Time & Expense Entry screen to the item.   
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Invoice Journal 
The Invoice Journal is a record of the billing entries input into the system for a specified date range. It provides a list of invoices created and their 
breakdown for a given date range. Among the groupings for this report are invoice date and several client-based criteria. Filtering and date range 
options enable you to view only the information needed. 

 

Invoice Journal with no groupings, detail by Client in ascending order     
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Invoice Journal grouped by Invoice Date and detail by Client in ascending order    
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Invoice Journal grouped by Client Partner ID and Invoice Amount in descending order     
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Invoice Journal with no groupings and Include Invoice Detail checkbox marked     



Billing Reports 

84 Practice CS Sample Reports 

Drill-down capabilities for Invoice Journal report — Click any item in the detail line to open Detail Billing for the corresponding item.    
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Collection Reports 
Collection reports enable you to analyze your firm’s accounts receivable activity. They can assist you in 
determining which clients are delinquent on their accounts, what types of A/R activity (such as receipts, 
debits, and credit memos) have been applied, and which clients have had service charges assessed. 

The following reports are included in this section. 

Accounts Receivable Applications .............................................................................................................. 86 
Accounts Receivable Ledger ...................................................................................................................... 88 
Accounts Receivable Recap ....................................................................................................................... 90 
Accounts Receivable Summary .................................................................................................................. 93 
Collection Summary .................................................................................................................................. 100 
Invoice Receipts Analysis ......................................................................................................................... 105 
Receipt and Adjustment Journal ............................................................................................................... 108 
Service Charge Journal ............................................................................................................................. 112 
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Accounts Receivable Applications 
The Accounts Receivable Applications report shows debits and credits that have been applied to invoices and when the applications occurred. 
You can view the report from either a debit (service charges, debit memos) or a credit (cash, check, credit memos, write-offs) perspective.   

 

Accounts Receivable Applications grouped by Client Family, applied to credit items    
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Accounts Receivable Applications grouped by Client Partner, applied to debit items       
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Accounts Receivable Ledger 
The Accounts Receivable Ledger shows all activity for a client’s account, and provides a way for the firm to see which items have affected a 
client’s accounts receivable balance. The grouping options are client-based, and the filtering and date range options enable you to view only the 
information needed. 

 

Accounts Receivable Ledger grouped by Client Partner, and detail by Client ID in ascending order      
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Drill-down capabilities for Accounts Receivable Ledger report — Click any Date, Type, Reference, Debit, or Credit item in the detail line to 
open the appropriate screen. For example, click a receipt or adjustment type to open the corresponding item in the Receipt and Adjustment Entry 
screen, or click an invoice number to open the corresponding invoice in the Detail Billing screen.     
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Accounts Receivable Recap 
The Accounts Receivable Recap report provides a basic overview of accounts receivable activity for the specified date range. This report can be 
grouped by clients, staff, activities, engagements, projects, and their components. 

 

Accounts Receivable Recap with no groupings, detail by Engagement in ascending order   



 Collection Reports 

Practice CS Sample Reports 91 

 

Accounts Receivable Recap with no groupings, detail by Staff in ascending order   
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Accounts Receivable Recap chart with Detail by Client Office 

Drill-down capabilities for Accounts Receivable Recap report — N/A 
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Accounts Receivable Summary 
The Accounts Receivable Summary combines two different styles of reports: Recap & Aging. This provides a useful overview or summary of the 
status of accounts receivable (defined as the total of unpaid invoices, unpaid service charges, and open A/R adjustments). The grouping options 
are client-based, and the filtering and date range options enable you to view only the information needed. 

 

Accounts Receivable Summary with no groupings, detail by Client Family in ascending order     
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Accounts Receivable Summary grouped by Client Partner ID, and detail by Client Family in ascending order    



 Collection Reports 

Practice CS Sample Reports 95 

 

Accounts Receivable Summary with no groupings, detail by Client Partner ID in ascending order    



Collection Reports 

96 Practice CS Sample Reports 

 

Accounts Receivable Summary with no groupings, with Include Open Items Detail checkbox marked      
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Accounts Receivable Summary with Detail line Year-to-date, and Detail line 2 Previous Year Year-to-date, detail by Client Family in 
ascending order 
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Accounts Receivable Summary graph with Detail by Client Office 
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Drill-down capabilities for Accounts Receivable Summary report — Click any ID, Name/Description, or End Bal item in the detail line of the 
report to open the Accounts Receivable Ledger report related to the corresponding data.      
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Collection Summary 
The Collection Summary report provides a summary of receipts collected, how they were applied (invoices, debit memos, service charges, or 
unapplied), and average number of days to collection, to help you determine a client's payment habits. The grouping options are client-based, and 
the filtering and date range options enable you to view only the information needed.  

 

Collection Summary with no groupings, detail by Client Family in ascending order     
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Collection Summary grouped by Client Partner ID, detail by Client Family in ascending order    
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Collection Summary grouped by Client Office, detail by Client Family Sort Name in ascending order    
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Collection Summary with Detail line Year-to-date, and Detail line 2 Previous Year-to-date, detail by Client Family in ascending order    
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Collection Summary chart with Detail by Client Partner 

Drill-down capabilities for Collection Summary report — N/A 
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Invoice Receipts Analysis 
The Invoice Receipts Analysis report provides information about receipts in the specified date range that have been applied to invoices. This 
information can by grouped by client, staff, activity, engagement, projects, and their components. This report can be useful for firms that pay their 
staff commission based on dollars collected, not billed. 

 

Invoice Receipts Analysis with no groupings, detail by Engagement   
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Invoice Receipts Analysis with no groupings, detail by Staff   
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Invoice Receipts Analysis chart with Detail by Client Office 

Drill-down capabilities for Invoice Receipts Analysis report — N/A 
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Receipt & Adjustment Journal 
The Receipt and Adjustment Journal serves as a record of what was entered into the program for a specified date range. It can also provide a 
listing of receipt and adjustment entries entered for a given control date. In addition to client-based grouping options, the report can be grouped by 
control date, type, and bank account. The filtering and date range options enable you to view only the information needed. 

 

Receipt & Adjustment Journal grouped by Control Date, detail by Order Entered in ascending order    



 Collection Reports 

Practice CS Sample Reports 109 

 

Receipt & Adjustment Journal grouped by Bank Account ID, detail by Date in ascending order    
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Receipt & Adjustment Journal grouped by Client ID, detail by Type in ascending order     
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Drill-down capabilities for Receipt & Adjustment Journal report — Click any item in the detail line to open the Receipt & Adjustment Entry 
screen showing the corresponding item.    
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Service Charge Journal 
The Service Charge Journal is a journal of service charges created by the program and accepted by the 
user for a specified date range. The purpose of the report is to list service charges created for overdue 
accounts. In addition to client-based grouping options, the report can be grouped by service charge date. 
The filtering and date range options enable you to view only the information needed. 

 

Service Charge Journal with no groupings, detail by Client ID in ascending order     

 

Service Charge Journal grouped by Service Charge Date, detail by Client Name in ascending order   
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Drill-down capabilities — Click any item in the detail line to open the Assess Service Charges screen 
showing the corresponding item.     
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Reconciliation Reports 
Reconciliation reports provide summaries of your firm’s work-in-process, billings, and accounts 
receivable, and enable you to see the flow of your firm’s work over a specified period. These reports can 
serve as a check to verify that reports balance.  

The following reports are included in this section. 

Client Investment Analysis ........................................................................................................................ 116 
Period Reconciliation ................................................................................................................................ 121 
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Client Investment Analysis 
The Client Investment Analysis report shows both WIP and A/R aging. The purpose of the report is to show any unbilled WIP and uncollected 
receivables that the firm is at risk of losing. The grouping options are client-based, and the filtering and date range options enable you to view only 
the information needed.  

 

Client Investment Analysis grouped by Client Partner ID, detail by Client ID in ascending order     
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Client Investment Analysis grouped by Client Office ID and Client Partner ID, detail by Client ID in ascending order    
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Client Investment Analysis with no groupings, detail by Client ID in ascending order     
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Client Investment Analysis with Detail line Year-to-date, and Detail line 2 Previous Year Year-to-date   
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Client Investment Analysis graph with Detail by Client Office 

Drill-down capabilities for Client Investment Analysis report — N/A 
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Period Reconciliation 
The Period Reconciliation report is a summary of the firm's activity for the selected date range. It includes work-in-process, billing, and accounts 
receivable information. The Reconciliation report is a consolidation of the data from other Practice CS reports, and is a concise reporting of the 
activity for a given date range. The report can be used to easily see the flow from the beginning to the end of the date range, and is used as a tool 
to tie totals from detailed reports, such as the A/R Summary, WIP Summary, Billing Summary, and Billing Analysis reports. The report can show 
totals for the firm, or be grouped by other client criteria such as office or partner. The filtering and date range options enable you to view only the 
information needed. This report does not offer drill-down capability. 

 

Period Reconciliation – information for the whole firm    
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Period Reconciliation detail by Client Family in ascending order     
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Period Reconciliation graph with Detail by Client Partner 



Reconciliation Reports 

124 Practice CS Sample Reports 

Report Reconciliation 

Numbers next to figures in graphic below correspond to table on following page     
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# Report Column Total # Report Column Total 

1 WIP Summary Beg Bal 12 Invoice Journal Surcharges 

2 
WIP Summary 

Production Analysis 

Produced 

Billable Amt 
13 Invoice Journal Discounts 

3 
Billing Analysis 

WIP Summary 

Amount 

Billed – Billing Adj 
14 Invoice Journal Sales Tax 

4 
Billing Analysis 

WIP Summary 

Progress Bill Amt 

Progress 
15 Invoice Journal Service Tax 

5 Billing Analysis Amount + Progress Bill 
Amt 16 

Invoice Journal 

Accounts Receivable Summary 

Invoice Amount 

Invoices 

6 WIP Summary End Bal 17 
Accounts Receivable Ledger 

Accounts Receivable Summary 

Beg Bal 

Beg Bal 

7 
Billing Analysis 

WIP Summary 

Amount 

Billed – Billing Adj 
18 

Accounts Receivable Summary 

Invoice Journal 

Invoices 

Invoice Amount 

8 
Billing Analysis 

WIP Summary 

Adjusted 

Billing Adj 
19 Accounts Receivable Summary Receipts 

9 
Billing Analysis 

WIP Summary 

Billed Amount 

Billed 
20 

Accounts Receivable Summary 

Service Charge Journal 

Svc Chg 

Service Charge 

10 
Billing Analysis 

WIP Summary 

Progress Bill Amt 

Progress 
21 

Accounts Receivable Ledger 

Accounts Receivable Summary 

Balance 

End Bal 

11 
Billing Analysis 

WIP Summary 

Total Billed 

Billed + Progress 
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Project Management Reports 
Project management reports enable you to view and analyze your firm’s projects and tasks. These 
reports can help you to monitor the due dates and status of projects and tasks, and to identify variances 
between budgeted and actual amounts.  

If you are licensed for the Project Management module, the following reports are available.  

List of Project Templates ........................................................................................................................... 128 
Project Budget to Actual ............................................................................................................................ 131 
Project Listing ............................................................................................................................................ 135 
Project Tracking ........................................................................................................................................ 139 
Routing Sheet ........................................................................................................................................... 143 
Task Budget to Actual ............................................................................................................................... 147 
Task Tracking ............................................................................................................................................ 149 
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List of Project Templates 
The List of Project Templates report gives a brief overview of the templates that have been set up in 
Practice CS. It can be grouped by any of the columns that appear on the report. Filtering the report allows  
you to view only the information that you need.    
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List of Project Templates grouped by Engagement, detail by Project Template ID in ascending 
order       
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Drill-down capabilities for List of Project Templates report — Click any field in the report to open the 
Project Templates screen for the corresponding record.      
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Project Budget to Actual 
The Project Budget to Actual report shows the variances between budgeted hours and amounts and actual hours and amounts. This report can be 
used to show which projects came in over budget and which ones are under budget at various stages of the projects. It can also serve as a 
planning guide for future projects.     

 

Project Budget to Actual with no groupings, detail by Project Number in ascending order  
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Project Budget to Actual grouped by Project Tracking, detail by Project Number in ascending order       
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Project Budget to Actual grouped by Project Responsible and detailed by Target Complete in ascending order      
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Drill-down capabilities for Project Budget to Actual report — Click any field in the report to open the Project dialog.    
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Project Listing 
The Project Listing report provides an overall snapshot of the projects. It shows pertinent information such as the target start date, current due 
date, and budgeted amounts for projects. The report also has the ability to show task detail.    

 

Project Listing with no groupings, detail by Project Number in ascending order  
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Project Listing grouped by Project Assigned, detail by Priority in ascending order       
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Project Listing showing task detail for those projects that have tasks     
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Drill-down capabilities for Project Listing report — Click any field in the report to open the Project dialog.     
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Project Tracking 
The Project Tracking report is intended to show how each project is progressing. It can indicate which projects are at or near completion as well as 
those at risk of falling behind. It can help a manager allocate resources to those projects that need the most work.     

 

Project Tracking with no groupings detail by Project Number in ascending order  
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Project Tracking grouped by Project Tracking, detail by Project Number in ascending order      
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Project Tracking grouped by Project Responsible, detail by Current Due Date in ascending order      
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Drill-down capabilities for Project Tracking report — Click any field in the report to open the Project dialog.    
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Routing Sheet 
The Routing Sheet report shows details about a project and any tasks associated with the project. The 
purpose of having one page per project is so that the sheet can be routed from person to person until the 
project is complete. When someone signs off on the sheet, it can be given to the next person along with 
the required paperwork so that they can begin their work.      
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Routing Sheet grouped by Project Assigned, detail by Activity in ascending order    
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Drill-down capabilities for Routing Sheet report — Click any project field in the report to open the 
Project dialog.  
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Click any of the task fields in the Routing Sheet report to open the Task dialog.   
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Task Budget to Actual 
The Task Budget to Actual report shows variance between budgeted and actual hours and amounts per task. The report is detailed by Task, and 
can be grouped by criteria related to Staff, Task, Client, and Project.    

 

Task Budget to Actual grouped by Project    
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Drill-down capabilities for Task Budget to Actual report — Click any field to open the Task dialog.     

 

 



 Project Management Reports 

Practice CS Sample Reports 149 

Task Tracking 
The Task Tracking report shows which employees are assigned to different projects. It is effective in showing which tasks are ready to begin, who 
is working on them, and status of the tasks.     

 

Task Tracking with no groupings, detail by Project Number in ascending order   
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Task Tracking grouped by Staff      
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Drill-down capabilities for Task Tracking report — Click any field to open the Task dialog.    

 

 

 



Project Management Reports 

152 Practice CS Sample Reports 

 

 



  

Practice CS Sample Reports 153 

Client Management Reports 
Client management reports enable you to view and analyze your firm’s interactions and communications 
with its clients and contacts, to identify successful strategies for winning clients, and to analyze why other 
efforts are less successful.  

If you are licensed for the Client Management module, the following reports are available.  

Clients Won ............................................................................................................................................... 154 
Clients/Prospects Lost .............................................................................................................................. 156 
Interaction Listing ...................................................................................................................................... 157 
 
 

 

 



Client Management Reports 

154 Practice CS Sample Reports 

Clients Won 
The Clients Won report shows the date each of your firm’s clients was “won” along with the reason, and shows who referred the client and the 
client’s office and partner. It enables you to track how your firm is winning clients and who is referring clients to your firm.    

 

Clients Won grouped by Client Won Reason 
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Clients Won grouped by Client Referred By     

Drill-down capabilities Clients Won report — N/A. 
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Clients/Prospects Lost 
The Clients/Prospects Lost report shows dates on which your firm lost clients along with the reasons, and shows to whom the client was lost. It 
enables you to see why and to whom your firm loses clients so you can concentrate on areas for improvement in client retention.    

 

Clients/Prospects Lost grouped by Client Lost Reason 

 

Clients/Prospects Lost grouped by Client Lost To    

Drill-down capabilities Clients/Prospects Lost report — N/A.   
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Interaction Listing 
The Interaction Listing report shows interactions (such as phone calls) with clients and contacts, along with interaction types, dates, client 
associations, and the subject and content of each interaction. It enables you to track communications with your firm’s contacts.     

  

Interaction Listing grouped by Of Client, detail by Date/Time 
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Interaction Listing grouped by Source, detail by Source    
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Drill-down capabilities for Interaction Listing report — Click any field to open the related setup screen.       
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Staff Management Reports 
Staff management reports enable you to view and analyze staff workload, and to track scheduled benefits 
such as vacation, sick, and comp time. You can use the staff management reports to review your firm’s 
scheduled items such as phone calls, meetings, and to-do items; identify staff members who are 
overbooked or underbooked so that you can reassign tasks as needed; and identify variances between 
targets hours and actual hours to determine whether your firm is on track to meet financial targets 
throughout the year. 

If you are licensed for the Staff Management module, the following reports are available.  

 

Calendar Listing ........................................................................................................................................ 162 
CPE Course Cost Analysis ....................................................................................................................... 162 
CPE Course Credit Listing ........................................................................................................................ 164 
Schedule Item Detail ................................................................................................................................. 165 
Schedule Item Listing ................................................................................................................................ 165 
Staff Assigned Summary ........................................................................................................................... 168 
Staff Benefits Summary ............................................................................................................................ 168 
Staff Capacity Analysis ............................................................................................................................. 171 
Staff Schedule Summary .......................................................................................................................... 171 
Staff Target Summary ............................................................................................................................... 174 
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Calendar Listing 
The Calendar Listing report shows schedule item information by scheduled date / time. The report date range is based on scheduled dates (week, 
month, period, 6 months, 12 months, custom, and so on). The detail line is based on scheduled start or end date. 

 

Calendar Listing report based on Target Start date, grouped by Client 
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CPE Course Cost Analysis 
The CPE Course Cost Analysis report analyzes the cost per credit for a CPE course. When a CPE course is associated with a time or expense 
entry, the staff cost and the expense cost are also factored into this analysis. 
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CPE Course Credit Listing 
The CPE Course Credit Listing report shows CPE courses and the staff who attended for the specified date range. Course information includes 
description, sponsor, format, location, target complete date, and number of credits. 

   



 Staff Management Reports 

Practice CS Sample Reports 165  

Schedule Item Detail  
This report is similar to the Schedule Item Listing report but includes columns for Remaining Hours, Scheduled Hours, and Unscheduled Hours. 
You can mark the Include Calendar Entry Detail checkbox on the Layout tab for a subreport that shows all the open calendar entries for each 
schedule item. 
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Schedule Item Listing 
The Schedule Item Listing report allows you to generate a list of schedule items by date range and grouped by various schedule item properties. 

     

Schedule Item Listing based on Target Start, grouped by Assigned 



 Staff Management Reports  

Practice CS Sample Reports 167  

Drill-down capabilities — Click any field in the Schedule Item Listing report preview to drill down to the 
setup screen for the corresponding record.   
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Staff Assigned Summary 
The Staff Assigned Summary report shows staff target work hours, assigned hours, remaining hours, and work load for the specified date range. 
You can also mark the Include Schedule Item Detail checkbox on the Layout tab to see the priority, status, and start and complete dates, for each 
schedule item that makes up the assigned hours for the staff member. 
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Staff Benefits Summary 
The Staff Benefits Summary report shows staff and their active benefit balances (beginning balance, earned, used, and current balance). You can 
also mark the Include Benefits Detail checkbox on the Layout tab to obtain the earned and used history for each displayed benefit. 

   

Staff Benefits Summary year-to-date
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  Staff Benefits Summary year-to-date, with benefits detail
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Staff Capacity Analysis 
The Staff Capacity Analysis report provides a way to see staff availability (target hours - scheduled hours) for up to 18 periods at a time. Use this 
report to see how many hours are available for a specific staff member, office, or for the firm. Available hours can be grouped by day, week, 
month, or period, and by several staff- and firm-level options. 
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Staff Schedule Summary 
The Staff Schedule Summary report shows staff target work hours, scheduled hours, available hours, and work load for the specified date range. 
You can also mark the Include Calendar Entry Detail checkbox on the Layout tab to see the type, priority, status, and start and end dates, for each 
schedule item that makes up the assigned hours for the staff member. 

 

 Staff Schedule Summary year-to-date 
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Staff Schedule Summary year-to-date with calendar entry detail 
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Staff Target Summary 
The Staff Target Summary report allows you to quickly see how staff members' actual hours compare with their target hours for the selected date 
range. 

  

Staff Target Summary with Detail line Period-to-date   
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